
LAN Manager Help Contents
This index contains a list of the Help topics available for LAN Manager. Use the scroll bar to see the 
topics not visible in the Help window. These Help topics briefly explain how to perform each LAN 
Manager task. You can also get detailed help about filling in a LAN Manager dialog box by choosing the 
Help button in each dialog box.

Getting Started
Starting the Workstation
Logging on to the Network

Using Network Drives
Connecting to a Network Drive
Disconnecting from a Network Drive

Using Network Printers
Connecting to a Network Printer
Disconnecting from a Network Printer
Viewing Printer Queues

Changing Passwords
Changing Your Password

Messaging
Receiving a Message
Sending a Message
Using the WinPopup Utility

Quitting LAN Manager
Logging off from the Network
Stopping the Workstation



Logging on to the Network
Logging on to the network identifies you on the local-area network and establishes you as the user of 
the workstation. Logging on lets you use network files and printers.

To log on to the network:
1. From the Main group window, choose Control Panel.
2. From the Control Panel window, choose Network.
3. From the Account menu of the Networks-LAN Manager dialog box, choose Logon.
4. From the LAN Manager Logon dialog box, type your logon name, password, and domain.
5. Choose OK.

Related Topics
Logging Off from the Network
Changing Your Password



Viewing Printer Queues
You can view printer queues to which you have connections, to determine where to send a print job or to
monitor jobs sent to a particular queue.

To view the printer queues you are connected to:
From the Main group window, select Print Manager.

The printers you're connected to are displayed, along with any jobs you have waiting to print on 
those printers.

When you print a file, Print Manager displays a printer queue and shows only the files you sent to that 
printer. You can also view the files in the queue that other users have sent to that printer.

To view all files in a printer queue:
1. From the Main window, choose Print Manager.
2. From the Print Manager window, select a printer.
3. From the View menu, choose Selected Net Queue.

In addition to viewing the printer queues you are connected to, you can also view the printer queues on 
a printer that you are not connected to.

To view other printer queues:
1. From the Main window, choose Print Manager.
2. From the View menu, choose Other Net Queue.
3. Type the path of the network printer you want to view.
4. Choose View.

Related Topics
Connecting to a Network Printer



Disconnecting from a Network Drive

You can disconnect a drive from a file resource when you are finished using it or when you want to use 
the drive letter for a different connection.

To disconnect a network drive:
1. From the Main window, choose File Manager.
2. From the Disk menu, choose Network Connections.
3. From the Network Drive Connections box, select the drive you want to disconnect.
4. Choose Disconnect.
5. Choose Close.

Related Topics
Connecting to a Network Drive
Disconnecting from a Network Printer
Connecting to a Network Printer



Sending a Message
You can send messages to other network users through the Networks-LAN Manager dialog box or 
through WinPopup. Before you can send a message, you must know the user's logon name, 
computername, or message alias.

To send a message through the Networks-LAN Manager dialog box:
1. From the Main group window, choose Control Panel.
2. From the Control Panel, choose Network.
3. From the Message menu of the Networks-LAN Manager dialog box, choose Send.
4. From the Send dialog box:

In the To box, type the logon name, computername, or message alias of the user(s) you want to send
the message to.
In the Message box, type a brief message.

5. Choose OK.

To send a message through WinPopup:
1. Choose WinPopup.
2. From the WinPopup dialog box, choose Send...
3. From the Send dialog box:

In the To box, type the logon name, computername, or message alias of the user(s) you want to send
the message to.
In the Message box, type a brief message.

4. Choose OK.
5. Minimize WinPopup. (If you close WinPopup rather than minimize it, you will not be able to receive 

messages from the network.)

Related Topics
Receiving a Message
Using the WinPopup Utility



Receiving a Message

When you receive a message, the WinPopup icon "pops up" to indicate that you have a message. 

To read a message:
1. Double-click the WinPopup icon. The WinPopup dialog box appears and the first message is 

displayed. 
2. Read the displayed message. When you are finished, choose Discard. If there are additional 

messages, the next message appears. Read and discard each additional message in turn.
3. When you have read and discarded all the messages, WinPopup will automatically minimize.

Related Topics
Sending a Message
Using the WinPopup Utility



Using the WinPopup Utility

When Microsoft LAN Manager is configured for the Messaging service, the WinPopup utility is started 
each time you start the Windows graphical environment, and the WinPopup icon appears at the bottom 
of your screen.

The WinPopup utility enables you to receive messages from other network users. When you receive a 
message, the WinPopup icon "pops up" to indicate that you have a message. When you double-click the
WinPopup icon, the WinPopup dialog box appears and displays received messages. When you have 
read and discarded all the messages, WinPopup will automatically minimize. 

To send a message through WinPopup:
1. Choose WinPopup.
2. From the WinPopup dialog box, choose Send...
3. From the Send dialog box:

In the To box, type the logon name, computername, or message alias of the user(s) you want to send
the message to.
In the Message box, type a brief message.

4. Choose OK.
5. Minimize WinPopup. (If you close WinPopup rather than minimize it, you will not be able to receive 

messages from the network.)

Related Topics
Sending a Message
Receiving a Message



Changing Your Password

To maintain security, it is a good idea to change your network password occasionally. Also, your network 
administrator may set password expiration dates, requiring you to change your password occasionally.

To change your password:
1. From the Main group window, choose Control Panel.
2. From the Control Panel window, choose Network.
3. From the Account menu of the Networks-LAN Manager dialog box, choose Change Password.
4. In the Change Password dialog box type your logon name if it does not already appear, type or 

select the name of the server or domain where you want your password changed, type your old 
password, your new password, and (to confirm) type the new password again.

5. From the Change Password dialog box, choose OK.
6. From the Account menu of the Networks-LAN Manager dialog box, choose Exit.
7. From the Settings menu of the Control Panel window, choose Exit.

Related Topics
Logging on to the Network



Logging off from the Network
Logging off removes your logon name and password from the workstation, and cancels any of your 
existing connections to file resources and printers. It also closes any open files and ends all programs 
you have running on the network.

To log off from the network:
1. From the Main group window, choose Control Panel.
2. From the Control Panel window, choose Network.
3. From the Account menu, choose Logoff.

Related Topics
Logging on to the Network
Stopping the Workstation



Stopping the Workstation

Logging off logs you off from the network, but your computer still remains active on the network. To 
remove your computer from the network, you must stop the workstation.

To stop the workstation:
At the MS-DOS prompt, type 

net stop workstation

Related Topics
Logging off from the Network
Logging on to the Network
Starting the Workstation



Starting the Workstation

In order to use network resources and exchange messages with other users, you must start the 
workstation. The workstation must be started before you start the Windows graphical environment. Exit 
the Windows environment if it is currently running, and then start the workstation.

To start the workstation:
At the MS-DOS prompt, type

net start workstation

Related Topics
Logging on to the Network
Logging off from the Network
Stopping the Workstation



Restoring Network Connections at Log On

When you log off from the network, all of your current network connections are saved and will be 
reconnected the next time you log on. This is an option that can be turned off or on. The default is on.

To turn the Restore Connections at Log On option on or off:
1. From the Main group window, choose Control Panel.
2. From the Control Panel, choose Network.
3. From the Options menu:

To turn off the option, clear Restore Connections at Log On.
To turn on the option, select Restore Connections at Log On.

Related Topics
Logging on to the Network
Connecting to a Network Drive



Connecting to a Network Drive
When you connect to a network drive, you are connecting a drive on your computer to a server or server
alias on the network. The files and directories available on a server are called file resources. After you 
connect a drive to a server or a server alias, you can use its directories and files just like those on your 
own computer.

To connect to a network drive:
1. From the Main group window, choose File Manager.
2. From the Disk menu, choose Network Connections.
3. From the Drives-Network Connections dialog box, type or select a drive letter and a network path; or 

type or select a drive letter, a server or domain, and a file resource.
4. If you are prompted for a password, type the password in the box provided.
5. Choose Close.

Related Topics
Disconnecting from a Network Drive
Connecting to a Network Printer



Connecting to a Network Printer

When you connect to a network printer, you can print files by sending them from your computer to a 
printer queue on the network. Jobs are printed one by one, usually in the order they are received.

To connect to a network printer:
1. From the Main group window, choose Control Panel.
2. From the Control Panel window, choose Printers.
3. From the Printers dialog box, choose Connect.
4. From the Connect dialog box, choose Network.
5. From the Printers-Network Connections dialog box, select a devicename and type a network path; or

select a devicename, a server or domain, and a printer.
6. From the Printers-Network Connections dialog box, choose Connect.
7. If you are prompted for a password, type the password in the box provided.
8. From the Printers-Network Connections dialog box, choose Close.
9. From the Connect dialog box, choose OK.
10. From the Printers dialog box, choose Close.
11. From the Settings menu of the Control Panel window, choose Exit.

Related Topics
Disconnecting from a Network Printer
Connecting to a Network Drive
Viewing Printer Queues



Disconnecting from a Network Printer
You can disconnect from a printer when you are finished using it or when you want to use the 
devicename for a different connection.

To disconnect from a network printer:
1. From the Main group window, choose Control Panel.
2. From the Control Panel window, choose Printers.
3. From the Printers dialog box, choose Connect.
4. From the Connect dialog box, choose Network.
5. From the Printers-Network Connections dialog box, select the printer you want to disconnect from.
6. From the Printers-Network Connections dialog box, choose Disconnect.
7. From the Printers-Network Connections dialog box, choose Close.
8. From the Connect dialog box, choose OK.
9. From the Printers dialog box, choose Close.
10. From the Settings menu of the Control Panel window, choose Exit.

Related Topics
Connecting to a Network Printer
Disconnecting from a Network Drive
Connecting to a Network Drive



To change your password:
1. In the Change Password for User box, type your logon name.
2. In the Change Password On box, type or select the domain or server where you want to change your 

password.
3. In the Old Password box, type your old password.
4. In the New Password box, type a new password.
5. In the Confirm New Password box, type your new password again.
6. Choose OK.



To change the password:
1. In the Old Password box, type your old password.
2. In the New Password box, type your new password.
3. In the Confirm New Password box, type your new password again.
4. Choose OK.



To supply a password:
1. In the Password box, type the password for the network connection.
2. Choose OK.

If you don't know the password, choose Cancel and see your administrator.



To connect to a network drive:
1. In the Drive Letter box, type or select a drive letter.
2. In the Network Path box, type the path of the file resource, or from the Show File Resources on box, 

select a server or domain.
3. If you selected a server or domain, from the File Resources in box, select a file resource.
4. Choose OK.



To browse file resources and connect to a network drive:
1. From the Drives-Network Connections dialog box, do one of the following:

From the Show File Resources on box, select a server or domain; and from the    File Resources 
in box, select a file resource of that server or domain.
Or,

In the Network Path box, type the path of a file resource (for example, \\MKTG).
2. Choose Connect.
3. If necessary, type a password.
4. Choose Close.



Connecting to and Disconnecting from Network Printers

In the Printers-Network Connections dialog box you can:
Connect to network printers
Disconnect from network printers
Connect to previously available printers

To connect to a network printer:
1. In the Device Name box, type or select a devicename. 
2. In the Network Path box, type the path of the network printer, or from the Show Printers on box, select

a server or domain.
3. If you selected a server or domain, from the Printers in box, select a printer.
4. Choose Connect.
5. Choose Close.

To disconnect from a network printer:
1. From the Network Printer Connections box, select the printer you want to disconnect from.
2. Choose Disconnect.
3. Choose Close.

To connect to an unavailable printer:
1. From the Network Printer Connections box, select an unavailable printer. An unavailable printer is 

preceded by a grayed printer icon. 
2. Choose Reconnect. If the printer is available, you are connected and the icon will no longer be 

grayed.
3. Choose Close. 



To browse and connect to a printer:
1. From the Printers-Network Connections dialog box, do one of the following:

From the Show Printers on box, select a server or domain; and from the Printers in box, select a 
printer available from that server or domain.
Or,

In the Network Path box, type the path of a network printer (for example, \\MKTG\LASER).
2. Select a device name.
3. Choose Connect.
4. If necessary, type a password.
5. From the Printers-Network Connections dialog box, choose Close.
6. From the Connect dialog box, choose OK.
7. From the Printers dialog box, choose Close.
8. From the Settings menu of the Control Panel window, choose Exit.



To send a message:
1. In the To box, type a logon name, computername, or message alias.
2. In the Message box, type a brief message.
3. Choose OK.



To disconnect from a network drive:
1. From the Network Drive Connections box, select the network drive you want to disconnect from.
2. Choose Disconnect.
3. Choose Close.



LAN Manager Glossary

administrator
computername
devicename
domain
drive letter
file resource
local-area network
logon name
message alias
network resource
password
printer queue
server
server alias
workstation



administrator

A person responsible for maintaining the local-area network. This person typically sets up the network, 
assigns logon names and passwords, and helps users.



computername

The name of a workstation or server on the local-area network.



devicename

The name you assign to make a connection to a network printer. You can use devicenames LPT1: 
through LPT3:.



domain

An administrative group of computers on the network. Each domain includes servers and workstations 
used by a group of users who have similar needs and concerns.



drive letter

The letter you assign to make a connection to a file resource. You can use drive letters D: through Z: 
that are not already in use by a local drive or network connection.



file resource

Files and directories available on a server.



local-area network

A group of personal computers that can communicate with each other and share network resources, 
such as files, printers, and communication devices.



logon name

A unique name that identifies you on the network. Ask your administrator for your logon name.



message alias

A name used to receive messages at a LAN Manager workstation.



network resource

Files, printers, and communication devices available on the network.



password

A confidential identifier that you supply when you log on to the network or connect to a network 
resource. Ask your adminstrator for your password.



printer queue

A queue that holds the jobs sent to a printer. A printer queue is a waiting line for print jobs.



server

A computer on the local-area network that controls access to resources, such as file resources, network 
printers, and communication devices.



server alias

A one-word name an administrator assigns to represent a network resource.



workstation

A computer that is part of the local-area network.



old password

The password you are currently using.



new password

A password you choose to replace your old password.



Network Path box

In the Network Path box you can type the path of a file resource, or if you are in your logon domain, you 
can type a LAN Server alias.

The path of a file resource is the computername of the server followed by the name of the file resource. 
The computername of a server is preceded by two backslashes (\\); a file resource is preceded by one 
backslash (for example, \\MARKETING\SALESQ1). 

A LAN server alias is a one-word name an administrator assigns to represent a network resource. 
Instead of typing the network path of a network resource, you can type a LAN server alias (for example, 
ORDERS).



Network Path box

In the Network Path box you can type the path of a network printer, or if you are in your logon domain, 
you can type a LAN server alias.

The path of a network printer is the computername of the server followed by the name of the printer 
resource. The computername of a server is preceded by two backslashes (\\); a printer resource is 
preceded by one backslash (for example, \\MARKETING\SALESQ1). 

A LAN server alias is a name an administrator assigns to represent a network printer. Instead of typing 
the network path of a network resource, you can type a LAN server alias (for example, ORDERS).



Show File Resources on box

The Show File Resources on box displays the domains and servers that have file resources available.



File Resources in box

The File Resources in box shows the resources that are available in the domain or on the server you 
selected from the Show File Resources on box.



Show Printers on box

The Show Printers on box displays the domains and servers that have printers.



Printers in box

The Printers in box shows the printers that are available on the server or in the domain you selected 
from the Show Printers in box.



Network Printer Connections box

The Network Printer Connections box shows the printers you are currently connected to.



To start the workstation:
1. Exit Windows.
2. At the MS-DOS prompt, type

net start workstation



Your password is a confidential identifier that you supply when you log on to the network.

Try typing your password again. If you don't know your password, see your administrator.



Your logon name is a unique name that identifies you on the network.

Try typing your logon name again. If you don't know your logon name, see your administrator.



A domain is an administrative group of computers on the network. Each domain includes servers and 
workstations used by a group of users who have similar needs and concerns. If you don't know which 
domain you should use, see your administrator.



The drive letter you chose is being used by another connection on your computer.
If you want to override the existing connection, choose Yes.
To keep the existing connection, choose No.
To cancel the action, choose Cancel.



The connection you want to delete is a saved connection. If deleted, it will not be automatically 
reconnected the next time you log on.



You have used all available connections. To make another connection, first delete an existing 
connection.



There is a problem with accessing the LMUSER.INI file in the LANMAN directory. The file may already 
be open or it may be damaged.

Check whether the LMUSER.INI file is open in another session. If so, close it.
If the LMUSER.INI file is not open, it is corrupted. Delete the LMUSER.INI file, and LAN Manager 

will automatically create a new one.


